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What is GoManage?
GoManage is a web-based management and organization tool. It enables teachers to effectively
manage and assess students' documents created on their computers. When students sync their
computers, GoManage retrieves their documents from the computers and stores them on
GoKnow's secure website. From any networked computer, teachers can review and assess
student work, distribute assignments and provide feedback, as well as distribute and delete
applications. Parents can also review their child's work from their home computer

GoManage enables teachers to:
e Organize and archive student work
Print and view student work
Send feedback to students
Distribute due dates and assignments
View applications installed on student computers
Install and delete applications
Back up and restore student work

Accessing GoManage from a computer
To access the GoManage web site, you must first be on a computer connected to the Internet.
Then, use a web browser, such as Internet Explorer or Firefox, and type the following URL into the
address bar: http://gomanage.goknow.com/. Notice that there is no “www” in the URL!

You will arrive at the main GoManage login screen (Figure 1).

Flease login to the system,

|

» username: |
GoManage
Llogin

If vou are logging in with a teacher or admin account and not a handheld
narne the group field may be left blank, Student and handheld uzer narnes
require the narme of the group to which they belong,

Each organization is assigned a GoManage group narne, Usually the group
narne is the school's name or a variation of the school's name, For example,
Lincoln Middle Schoal's group name might be "¥ecednms." Your technalogy
directar, and other technical staff likely know your group name,

Figure 1

* NOTE: Some schools have local servers. If this is the case, the URL to access GoManage will
be different. Your network administrator or IT specialist should be able to provide you with the
correct URL for your school.
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Logging in to GoManage
GoManage user accounts are typically set up by school administrators or instructional technology
staff. Prior to logging in to GoManage, you will need to obtain your login information from the
appropriate person at your school.

* NOTE: If your school or district is not able to provide you with your login information, please
email support@goknow.com. Be sure to include your name, school, position, and site coordinator’s
name and email address.

1. On the main GoManage login screen, enter your username and password in the
appropriate boxes.

* NOTE: Administrators are not able to look up your password. However, they can change it to
one you specify if you forget the one that was assigned originally.

2. You do not need to fill in a group name (although there is no problem if you do so).

3. Click the CED button.

4. This will bring you to the main GoManage screen (Figure 2).

| Introduction

‘ Welcome to the GoManage website. You can return to this screen at any time by clicking on the logo in the
GoManage upper left hand carner of your screen, You can click on a user or group in the left pane to select it for
viewing or modification.
logoff

The latest version of the GoManage Teacher Guide {dug. 27, 2007) is available here:

GoManage Teacher Guide 070827 pdf (432k)
requires acrobat reader

Q\\\

Mobilizing your curriculum

Copyright @ 2003-2007 Geknow! Inc. Copyright @ 2003-2007 The Regents of the University of Michigan.
All Rights Reserved,
GoManage™ is a tradermark of GoKnow! Inc, Use of this website is subject to our Privacy Policy,

Figure 2

* NOTE: The name of the folder on the left under the GoManage logo will depend on the way the
site was set up by your administrator.

Viewing computer contents
Once you have logged in to GoManage, the first thing you will want to do is add a computer or
device so that you can view its contents. Later, we will discuss how to set up groups, but for now,
we’ll start with adding your own computer to the list.

* NOTE: Before you can add a computer to a list is GoManage, you need to sync the computer
first. In order to sync, you will need to be connected to the internet first. Once you are connected to
the internet, launch GoSync on your device, log in, then click “sync.” For more information on using
GoSync, see Appendix B.

Once you have synced, you are ready to add your computer to the list!
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Adding your computer to the list

1. Click on the name of the folder below the GoManage logo on the left of the screen (Figure
3).

_—

GoManage -View-  [v]  -SendFesdhack- [v]

logoff Users in bold have not been sEnc'd since the last modification to their account,

There are no users in this group,

Q\\

Mehilizing your curriculum

Copyright @ 2003-2007 Goknow! Inc, Copyright @ Z003-2007 The Regents of the University of Michigan,
All Rights Reserved,
GoManage™ iz a trademark of GokKnow! Inc Use of thiz website is subject to our Privacy Policy,

Figure 3

2. The folder is the name of your first group. To add a computer to the group, click “edit group”
on the right of the bar at the top of the screen (Figure 4).

< O

Figure 4

3. A new window will pop up with a list of users (Figure 5). As mentioned previously, these
names are automatically added to this list the first time a user syncs. If your name is the
only one on the list, that’s because no one else has synced yet!

Group Name: MrTeacher

All Users: Group Members:
feacher . 0* teacher

"
Figure 5

4. Find your computer on the list and click on it to highlight it. Then click “Add.” For this
example, we will use the computer called “teacher” to represent the teacher’'s computer.
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5. Your computer will be added to the “Group Members” list on the right (Figure 6).

Group Name: Ms Teacher

Al Users: Group Members:
iteacher . teacher N

cancel | ok

Figure 6

6. When you have added your computer to the “Group Members” list, click “Ok.” The window
will close and you will return to the original GoManage window.

Viewing projects and files on your computer

Once you have added your computer, it will appear under the folder on the left of the screen. If you
click on the name of your computer, you will be able to view a list of the projects and files on the
computer (Figure 7). Files that are part of a project will be indented and listed below the project

name.

Vet Fites [elpgl Figge
GoManage Vg - w| | -SandFesdhack- v
Il
= move | copy | archive | delete
‘A Mr Teacher
‘ LaES Byt Tomidaw Masdh | 8e8, 2008 53919 AM
Current
C
[ & paya Projoet HLE Praject Mrch i, 2000 % 2671 AN Yy
E the vayas Migrasaft Word March L ivh, 3808 :: 2451 AM L
% The Maya PiCaMap Mirch L Sh, PO0E S 3651 AM L
B sayan tumbers Sketchy Mgach | Svh, TO0E S 36T AB o
Lurt Syeas Toacden, March 18k, 2008 9:39: 19 AN
move | copy | archive | delete
//;":0
Go
PG Ao il durt i
Capyagha § 03 100T Jemnavi fme. Capynight § 2063 206F The Regents of the Urivediny of bathugen
Al BEghEE Mafaenad
GaMpnaga™ b & Wadarnark of Goaingwl Ine Und of e wabiie b polded W oo Peliirs Palis
Figure 7
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You can view any of the files by clicking on the icon to the left of the file name (to the right of the
check box, Figure 8).

Last Sync
[0 © Maya Project HLE Project March 12th, 2008 2:26:51 AM 0
@ The Mayas Microsaft WWard March 15th, 2008 9:26:51 AM of
élhe Maya PiCoMap March 15th, 2008 9:26:51 AM ¥
ﬁ? Mavan Numbers Sketchy March 15th, 2008 9:26:51 AM )
Figure 8

This will open the file in a new window (Figure 9). Close the window to return to the original list of
files.

Hut.:
.
Gods and Goddesses acritices [+ - A
K- - Central America
(Centro] ferice)
_Bel iefs Alived in
Ahad
K, have nany Geography
+ -
Chichen Itza m
5 - W built many
ST -
-
¥ -
Y-
¥ -
5 - -
320 A.D
‘_
om 900 A.D
Priests and Nobles [+ -

{Cra{‘tsmen and Traders)

{Farmers, Workers,Enslaved People }

Figure 9

* NOTE: If the window does not appear, check that you did not already have a document open
and that the new window is not hidden by the original GoManage window.
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Archiving and deleting projects and files
In addition to viewing projects and files, you can also archive them and delete them. Files that are
a part of a project can only be archived or deleted if the whole project is archived or deleted.

* NOTE: After archiving or deleting a file or project on GoManage, you must sync your computer
for the changes to be reflected on your device.

Archiving

Archiving projects and files removes them from the computer, but keeps them on the GoManage
server so that you can still access them. Projects and files that are archived are kept under a
separate tab from current projects and files. At any time, you can un-archive projects and files and
send them back to the computer.

To archive projects:
1. Click the box next to the project you wish to archive (Figure 10). You can archive multiple
projects at one time — just click on the boxes next to each project.

move | copy | archive | delete

Last Sync: Tuesday, March 18th, 2008 9:35:19 AM

Current
| MName Last Sync Shared
= Maya Project HLE Project March 18th, 2008 9:26:51 AM o
M the Mavas Microsoft Word March 18th, 2008 9:26:51 AM R
U The Maya PiCoMap March 18th, 2008 $:26:51 AM R
: B8 mavan Numbers Sketchy March 18th, 2008 9:26:51 AM K

Last Synct Tuesday, March 18th, 2008 2:139:19 &AM

Figure 10

* NOTE: To archive files that are not associated with a project, follow the same steps, but check
the box next to the file, not the project.

2. Once you have selected the project(s) you wish to archive, click the “archive” button located
above the list of projects and files (Figure 11).

move | copy i archive | delete
Last Sync: Tuesday, March 12th, 2002 2:39:19 AM
Current
Name Tvpe Last Sync Shared

i & Maya Project HLE Project March 18th, 2008 3:26:51 AM 7
M 11 Mayas Microsoft Word March 15th, 2008 9:126:51 AM o
é""‘@The - RiCaMap March 18th, 2008 9126:51 &M o
B Mayan Numbers Sketchy March 1&th, 2003 2:26:51 AM 7

Last Sync: Tuesday, March 12th, 2002 2:39:19 AM

Figure 11

3. The project (or file) you selected will disappear from the list of current files. It has been
moved to the archived list.

4. To view archived projects and files, click on the “Archive” tab next to the “Current” tab on
the file list (Figure 12, next page). You will see a list of the projects and files in your archive.
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move | copy | unarchive | delete
Last Sgnc: Tuesday, March 15th, 2008 9:39:13 &M .m
[ ]

MName Tvpe Last Sync
[0 & maya Project HLE Project March 18th, 2008 9:26:51 AM
mThe Mayas Microsoft Word March 18th, 2008 9:26:51 AM
E""QThe Maya PiCoMap March 18th, 2008 9:26:51 AM
ﬁ Mayan Numbers Sketchy March 18th, 2008 9:26:51 AM

Last Synct Tuesday, March 15th, 2008 2:39:119 &M

Shared

KR

Figure 12

5. The next time you sync your computer, the project (or file) you archived will be
automatically removed from the computer, but will remain in the archive on GoManage.

6. If you want to move a project (or file) back to the “Current” list and back to the computer,
simply click the box next to the project (or file) in the archive, and then click “unarchive”

(Figure 13). Your project (or file) will be returned to the “Current” list.

move | copy | unarchive | delete
Last Synct Tuesday, March 15th, 2008 9:139:19 &AM
Archive
] Mame Type Last Sync Shared
i Maya Project HLE Project March 18th, 2008 9:26:51 AM R
EThE Mayas Microsoft Ward March 18th, 2008 9:26:51 AM r_‘i?
EMQThe Maya PiCoMap March 19th, 2008 9126151 AM R
ﬁ Miemam Mumisere Sketchy March 18th, 2008 9:26:51 AM N
Last Sync: Tuesday, March 185th, 2008 2:3%:19 aM
Figure 13

7. The next time you sync your computer, the unarchived project (or file) will be put back on

your computer.

Deleting

* IMPORTANT: Deleting projects and files is PERMANENT. Make sure you want to do this before

you proceed!

To delete projects or files, you follow steps similar to archiving.

1. Click the box next to the project (or file) you wish to delete (Figure 13, previous page). You
can delete multiple projects or files at one time — just click on the boxes next to each project

or file.

2. Once you have selected the projects (or files) you wish to delete, click the “delete” button

located above the list of projects and files (Figure 14).

move | copy | archive | delete

Last Sync: Tuesday, March 18th, 2008 9:39:19 AM

Current
Name Last Sync Shared
¥l & Maya Project HLE Praoject March 15th, 2008 912651 AM 7
E The Mayas Microsoft Word March 18th, 2008 9:26:51 AM f
® The Maya PiCoMap March 18th, 2002 9:26:51 AM &
B Wiivam Mumiaers Sketchy March 18th, 2008 9:26:51 AM 1
Last Sync: Tuesday, March 18th, 2008 3:39:19 AM
Figure 14
Copyright 2008, GoKnow! Inc. Last Updated:
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3. The project (or file) you selected will disappear from the list of current projects and files. It

has been moved to the trashcan.

4. To view deleted projects (or files), click on the “Trashcan” tab next to the “Archive” tab on
the file list (Figure 15). You will see a list of the files in your Trashcan.

move | copy | undelete

Last Sync: Tuesday, March 18th, 2008 9:29:19 AM

Lazt Sync: Tuesday, March 18th, 2008 9:39:19 AM

] WETITE Type

(] < Maya Praject HLE Project
g""@The Mayas Microsoft Ward
B The Maya PiCaMap
i Mayan Mumbers Skatchy

Last Sync
March 18th, 2008 9126:51 AM

March 1&th, 2008 $126:51 AM
March 1&th, 2008 9:26:51 AM

March 1&th, 2008 9:26:51 AM

Shared

KKK

Figure 15

* NOTE: The list of projects and files in your trashcan will remain until the next time the computer
is synced. Once the computer has been synced, these projects and files will be removed from the
list in the trashcan and will be deleted permanently!

5. If you do not want to delete a project (or file), you need to undelete them before the next
time the computer is synced. To undelete a project (or file), click on the box next to the
project (or files) in the trashcan, and then click “undelete” (Figure 16). Your project (or file)
will be returned to the current list and will not be deleted.

move | copy | undelete
Last Sync: Tuesday, March 18th, 2008 9:29:19 AM
Trashcan

] Name Type Last Sync Shared

Vi & Maya Praject HLE Project March 18th, 2008 9:26:51 AM s
|E The Mayas Microsoft Ward March 18th, 2008 3:28:51 AM K
g""@The Maya PiCoMap March 18th, 2008 9:26:51 AM of
ﬁ T NUTEErS Sketchy March 128th, 2008 9:26:51 AM w

Lazt Sync: Tuesday, March 18th, 2008 9:39:19 AM

Figure 16

Working with groups

Before using the other features of GoManage, you need to set up groups of students. In this
section, you will learn to set up groups and subgroups, add and remove students from groups, and

delete groups.

* NOTE: Students can belong to more than one group. For example, a student may be in the
groups “Class Period 3” and also in the group “Red Team.” You can add a student to as many

groups as you want.

Copyright 2008, GoKnow! Inc.
All Rights Reserved
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Creating groups and subgroups

GoManage is set up using a hierarchical structure. Groups are listed on the left side of the screen.
At the top level is the main group set up by your school administrators. You have already added
your computer to this group. If you click on the name of the group (in this example, Mr Teacher),
you will see a list of computers in the group (Figure 17). Right now, there is only one computer.

i = - Sand Fesdioadk -
GoManage e ‘-' Send Foedback - |»
IS Laer i hald hask st bes penc'd gingg thot Lagt e st T e acceint
=N ; : teacher Harch D, 2008 B IR1PAM
B rescher

Go

Copymght @ T003-200T Gaknasl Inc Coppraght § T003-I00T Tha Fagants of the Univerey of Mahigan.
A1 Rights Rarsmad.
Sk anage™ i & rademark of Goksew! 1ns Uid of B webife o inliect te our Briggsy Balicy

o

Mhatsliging pime 0

Figure 17

* NOTE: Remember to have students sync prior to setting up groups — this will add their
computers to the list of available computers.

To create your first group (which will be a subgroup of the main group):
1. Click “add subgroup” on the right side of the bar at the top of the screen (Figure 18).

" il

=g - R - Sand Foed i = |5
GoManage : e
oS Lees i el b s b penc'd since the Lygr maSfc et T thes aoceu
_iﬂ ; teacher Harch D, 2008 B IR1PAM
L {ﬁ
Go 0
Mioksliaing your curviubes
Copymght § T003-2007 doknas| Inc Copprght § J083-IB0T Thae Ragents of the Universy of Mahigan
Al Rights Rerseved.
SoManage™ il o trademark of doknewl Tre Uie of e wibala & inksecl te our Brbppey Balics
Figure 18

2. A new window will pop up with a list of users (Figure 19). As mentioned previously, these
names are automatically added to this list the first time a user syncs.

Group Name:
Al Users: Group Members:
Alicia -~
Chris
Erika
Jenny
Johin
Kate
Matt
Raul

gl
teacher

[
Figure 19
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3. Type a name for your group in the box next to “Group Name.”

4. Select the students you wish to add to the group by clicking on their names on the left and
then clicking “Add.” You can select multiple students by holding down the “Ctrl” key on your
keyboard while you click on names.

5. The student(s) you selected will be added to the “Group Members” list on the right (Figure

Group Mame: | Class 1
all Users: Group Members:
Alicia [~] Chris
Chris Erika
Erika Iohn
Jenny Kate
John
Kate
Matt
Ral =
teacher

v
cancel | ok

Figure 20

6. When you have added the group members you want, click “Ok.” The window will close and
you will return to the original GoManage window. You will now see a subgroup listed on the

left (Figure 21).
[
<
GOManage =i+ w = Bend Feedback - |»
loept] Whieri b bl Baves #at bases igna’d ddes tha Lait sedifie sties e thal st ust

teacher Masch Lith, 2008 130 19 AM
I s teachor
Go
Mobliring your urriubsm

Copysight @ 003- 2007 deknaw! Inc Copypright & 1003-200T The Regents of the Unkeriity of Michigan
all Rights Barareed.

T\

Gedlamaga™ is & Wademad of Jenee! [ne Use of this wabale |1 swbied 1o our Pasacy Pobe
Figure 21
7. If you click on the name of the folder (Class 1), you will see a list of students in the group,
as well as the last time they synced (Figure 22).
-
f
GOManagE =W - L -Sond Feedback - »
|oget Udard i b hive fas bass done'd dncs tha Lidt sedfiatian 16 Sair sdeeant

= Mr Teacher Chrig Janrry 3 1un 2008 148132 PM
T Llasz ] Erika Jenwary 3105, 2000 T4031 PM

= c".'“ John Jebsaay T10L 2008 B2 PM

& f“r:: Kate Juwusay 2155 2008 2:30:43 BM

ol
‘ Eate //FF
‘ma-’hnr ‘
Makilr rg your suriculam
ET‘:“::T f-.::?‘:l :o{lr Go¥nge! Irg. Copyright @& 30033007 The Regerds of the Urewerpity of ichigen.
-i-:-nhqnno"‘ i & tradamadk of Genovl 1o Use of thir webafle b subied o sur Prigace Polioy
Figure 22
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8. You can add a subgroup to Class 1 if you want. To do that, make sure you first click on
“Class 1” on the left side of the screen. Then click “add subgroup” from the bar at the top of

the screen (Figure 23).

- g

GoMan age =W - L -Sond Feedback - »

|oget Udard i b hive fas bass done'd dncs tha Lidt sedfiatian 16 Sair sdeeant
= Mr Teacher Chris Janwsry J1sn 2008 144130 PM
T Llazs Erika Janwary 314k I008 240131 PM
& cres John Jebsaay T10L 2008 B2 PM
W Erka Kate Jusunay 21 5% 2008 10043 PM
& John /f'_
‘ Eate /:":
‘ma-’r.n.' ‘
Maksiluring your currieulum

Copynght @ 300)-1007 Go¥nov! Ing. Copyright @ 20033007 The Regents of the Uneserpity of Michigan.
All Rights Reremed
GoManage™ if & rademark of Gekney) I Wie of this webeite b sulledt 1o sur Privacy Paliay

Figure 23

9. A window will pop up just like when you created Class 1. Follow the same steps to make
your new subgroup. Remember, students can be in multiple groups!

Figure 24 shows an example of a teacher’s groups and subgroups. In this example, the teacher
has 2 classes: Class 1 and Class 2. There are 2 groups in Class 1: the Blue Group and the Red
Group. There is 1 group in Class 2: the Green Group. This is just one example of a way to set up
your groups.

- Mr Teacher

=i Class 1
-2y Blue
Group

& Chris

& Eria

= Red
Group

& hn

& Kate
& chris
& Erka
& John
8| Kat=
ey ¢ :

" Cren

& Becca
& Eric
& Gordon
& Bacca
& Eric
& Gordon
& ke
B Megan
& teacher

Figure 24

To view student work, click on the computer icon next to their name, just like when you viewed the
work on your own computer.

Copyright 2008, GoKnow! Inc. Last Updated: Page 12
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Editing groups
Groups can be edited at any time. Students can be added and deleted as needed.

* NOTE: Deleting a student from a group does NOT delete that student’s work. To view a
student’s work, just add them back to a group. Only administrators can delete students from the
system entirely.

To edit a group:
1. Click on the name of the group you wish to edit, then click “edit group” on the bar at the top
of the screen (Figure 25).

1t aroun -
foa—
GDManage L bl - Sond Fopdback -~

oyt Uliari b6 bobd biwva fol baan dpic'd difa U Lii® avslific sthon i thal s2deuil

= Mr Teacher

John Hwer
< Class 1 Kate Jesuney TUew 2007 ZI0AL BM
#_J Blee Group /.f""
4 ®od Growp fi
han
@ Go
=='.|t= Phokibring yomr curriosum
i Coppigh @ 2003-1007 Galney| Int Copyrght © J001-2007 The Begants of the Univarsily of Midvigan,
= Chres all Bights Fadeivad
i Erika GeManage™ iz o trademark of Gakaset Ene Use of thiz webaite iz subject to our Privacs Balicy.
& jakn
B ke
=11 Class 2
& teachar

Figure 25

2. A window similar to the one used to create the group will appear (Figure 26). Here, you can
change the group name, add new group members, and delete members from the group.

Group Name: |Fed Group
&l Users; - Group Members:
Chris ] John
Erika Kate
John
Kate E
teacher

(]
cancel | ok

Figure 26

3. Toremove a student from the group, select their name in the column on the right, then click
“remove.”
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4. When you are done making changes to the group, click “ok” at the bottom of the window to
return to the original GoManage window.

Deleting groups
Groups can be deleted at any time. You can delete groups at different levels, from the top level
down to individual subgroups.

* NOTE: Deleting groups does not delete student work. It only removes the grouping from the list.
You can re-create the group at any time if desired.

To delete a group:
1. Click on the name of the group you wish to delete, then click “delete group” on the bar at

the top of the screen (Figure 27).

GDM anage =g - w - Send Faedback - | v
agoff Uraeg i bl By et basn pyas d pincd ch 13r mepdifo pnian T thair 3SCH0NE,
—4 Mr Teacher
-q i
=) Blue Group
i a“"’ Group Kate Jawenty 21en 2007 230041 BM
Chiris /-"'
Werika ”';;0
@ o Go
R caee
Cagrysight @ 0093007 G ¥ Ine. Coprsigh 0032007 The Eagents of the Unkersity of Midhigan.
=21 Class 2 e R e L pipt sty oz
= teacher daddamege™ b & Wademaek of Gernav) Ind. Uis of thid vabile i fullec 1 dur Priy sy Bolipy,
Figure 27

* NOTE: When you click on a group to delete it, you will also delete any subgroups that are a part
of the main group. In the example above, if you deleted the group “Class 1,” you would also delete
the “Blue Group” and “Red Group” subgroups. If you only wanted to delete the “Blue Group,” then
click on the name “Blue Group” before clicking “delete group.”

2. A window will appear, asking you to confirm that you wish to delete the group and any
subgroups (Figure 28).

Clicking ©K will delete this group and all
subgroups, &re you sure you wish to do

this?
cancel | ok

Figure 28

3. Click “ok” to delete the group, or “cancel” if you don’t want to delete the group.
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Filters

Now that you have groups set up, there are a number of things you can do! One thing you can do
is set filters to view specific files. Filters can be set based on key words in the title of the file.

Filters can be applied to individual computers or groups of computers. To apply a filter to an
individual, first click on the name of the computer you wish to view. To apply a filter to a group of

computers, first click on the name of the group.

Setting filters
To set a filter:

1. After selecting the computer or group of computers to which you want to apply the filter,
click on the arrow next to “View” at the top of the screen (Figure 29).

F

e
—_— "
Gﬂmanagﬁ = iiwi - - Sond Feedback -
instalied Apps | archive | dalate
- Mr Teacher
i Class 1
=1 Blee Growp
1] Red Group = =
[ = maya Project HLE Project  March | b, 2000 314534 AR Y
&E:‘: B sy an Mumbers Skatchy  Mardh 1 ik, 2008 1128524 &M o
[ the Mayaz MICraSORt Ward March § ik, 2008 1114324 AM i
EK‘“ & The Maya FICOMED  Marak 3 bk, 2000 8154524 A o
=4 Class 2 O &= watarCyele HLE Project  March § ik, 2008 §1:45 24 A e
1 Green Group wm, Cyche Pocket Waord  March 1, 2000 10:45:234 AR o
‘HF'“ Euhd water Cyde Printout - EnchantodLeaming_com o0 0308 Mank Dk, 2008 11:45:24 AW )
‘- el - B buremesinderstanding the Weather's Water Crde V0D Pa0S  March 16wk 2008 114%:34 A o
Figure 29
2. Click on “Set Filter” at the bottom of the list.
3. A *“View Filter” window will appear (Figure 30).
@ view documents with any title.
O wiew documents by title.
comma separated list
cancel | ok
Figure 30
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4. In this window, you can create a filter that will limit the files displayed by key words in the
document title. Enter the key word or words to filter by, then click “Ok” (Figure 31).

O wiew documents with any title,
® wiew documents by title.

comma separatad list
Mava

cancel | ok

Figure 31

5. Click “OK” to return to the main GoManage window.

6. You will now see a list of all the files have that key word in their title.

Clearing filters
To clear a filter:

1. Click on the arrow next to “View” at the top of the screen (Figure 32).

>
GoManage - - - Sond Fopdback -
R Instalind dpps | archive | delete
- Class 1
13 Blee Growp
v Al Groen L HLE Murch 1 b, 45124 AN g
‘C el Maya Praject Propect Tk, ZOO 818524
& erks M siayan Mumbers Skobchy  Much 1k, 2008 1124524 &4 o
® B o mayas MicrOSoft Wiord March 1k, 2008 11343024 AM )
-G & Tha Mays FICOMED  Marh §ik, 2000 1154524 AN o
=4 Class 2 [0 & watercycle HLE Projoct  Maich 36w, 2008 § 154534 AX ]
#2 Green Group 3 water cycie Pocket Word M 1k, 2000 11:45:24 &4 of
R pecca [ Labsol water Cycle Printout - EnchantodLearing_com  WRDIPAgR  Mureh 16, 2008 11:45:24 AK o
‘E Em_, B bummis sunderstanding the Westher's Water Cyde "D Pa08  Much 161k, 2008 11043124 &M L)
Figure 32
2. Click on “All Files” to clear the filter and display all files again.
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Viewing applications

Using the “View” menu, you can also view a list of applications that are installed on a student’s
computer. Under the “View” menu, click on “Installed Apps.” You will see a list of applications and

version numbers (Figure 33).

2007 McrosoR Dfice Suste Service Padk 1 (5P1)
=. 2007 Mool Oficw Sate Servios Padc L [SP1)

‘Ka:n 2007 Microsolt Ofice Sulte Service Padk | (5P1)
2007 Mizresol Ofice Tuite Service Pad 1 (5P1)
= Class 2 2007 Macrosoll Oice Suste Service Padk 1 [5P1)
. - 2007 Microsolt Ofice Suite Service Padk 1 (5P1)
T Grewn Group 200F Micreaol e Saalta Sarvcs Pad | (5P1]
& peca 2007 MeTotoRt Cfice Sute Servios Pack 1 {5P1]
2007 Microsolt Dfice Sute Service Padk 1 (5P1)
=‘="': 2007 Microsol Ofcs Suite Service Padk L (SP1]
®- 2007 Macrosoll Ofce Suste Service Padk 1 (5P1)
kHEn 2007 Microsoft Cfice system
=y_.‘.q. fatzeun g
Aot Flash Mayer Actre
R reasn Adokes Flash Player Phugn
B soachor Adets Rusder &
Aspel Erehsh Caotionary 0. 50:2
Chienit Security Solution
CitePDF Writer 2.7
Cushapar Home
Crag-to-Des
G Aspell 50-3

e
GoManage
gk Hame: ULL-PC
Mprogolt 'Windows NT §.0.600] Serace Pack | (Busld 8001
=3 MrTeacher Memory: 20,8108 { 86,5068
=] & Lo 0%
=3 Closy 1 Ladi: Teachaer
10 Blee Growp
HEY And Graup 436 Benr: Tomsdur hatus Tsts 33008 3183 pua
o
2007 Macresoll Ofice Suste Servios Padk 1 (SP1)
‘I':I'l"i 2007 Microsolkt Ofice Sute Service Pad L (5P1]

Figure 33

* NOTE: Teachers are not able to remove software from student computers. However,

administrators can remove any applications.

Distributing projects

Copying projects

GoManage is a great tool for sending projects to your students. For example, if you create a
project for your students, you can upload it to GoManage and distribute it through the GoManage
website. Then, the next time your students sync, they will receive the project on their computers!

The easiest way to distribute project to students is by using the “copy” function.

To copy projects to students:

1. Find your computer on the list of groups on the left side of the GoManage screen. Click on

your computer.

2. Check the boxes next to the project or projects you wish to distribute to your students

(Figure 34).

move | copy | archive | delete

Lazt Synct Tussday, March 18th, 2008 9:39:19 &M

Current
] Mame Type
& Waya Project HLE Projact
e Mayan Mumbers Sketchy
[ 1he Mayas Microsoft Word
® Tha Maya PiCoMap

Last Sync: Tuesday, March 18th, 2008 9:39:19 &M

Last Sync
March 18th, 2008 9:26:51 AM

March 18th, 2008 9:26:51 AM
March 18th, 2008 2:26:51 AM

March 1&th, 2008 9:26:51 AM

Shared

K REK

Figure 34
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3. Once you have selected the projects you wish to copy, click the “copy” button located

above the list of files (Figure 35).

move | copy | archive | delete

Lazt Synct Tussday, March 18th, 2008 9:39:19 &M
Current

] Mame Type Last Sync Shared
¥l @ maya Project HLE Project March 18th, 2008 9:26:51 AM
= Mayan Mumbers Sketchy March 15th, 2008 2:26:51 AM

K REK

4. A window will appear asking where

[ the Mayas Microsoft Waord March 18th, 2008 2:26:51 AM
% he s PiCaMap March 18th, 2008 9:26:51 AM
Last Sync: Tuesday, March 18th, 2008 9:39:19 &M
Figure 35

you would like to copy the projects to (Figure 36). You

can copy projects to individuals, groups, and/or subgroups.

=i Class 1

& Chris
‘ Enka
& John

& Kate
#{ Class 2
ﬁ teacher

‘A Mr Teacher

1 Blue Group

=i Red Group
r & John
& Kate

shown above).

Figure 36

To copy projects to an individual, click on their name on the list (i.e. click on “Kate" in the list

To copy projects to a group or subgroup, click on the name of the particular group/subgroup

(i.e. click on “Blue Group” in the list shown above).

* NOTE: When you are copying projects to a group, projects will be distributed to all students in
that group as well as students in any subgroup of the group. In the example above, if projects were
copied to “Class 1,” they would be distributed to all students in Class 1 as well as students in the
Blue Group and Red Group, which are subgroups of Class 1.

Projects that you have just copied to a student will appear in bold on the list of current projects and

files on the student’s computer (Figure 37,

next page). This means that the student has not yet

synced to receive these files. Once the student syncs, the files will no long be bold, showing you

that the student has received them.
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E
L a Class 2 B Labol waker Cycle R - Enchantodloaming_com  "S0PS0S  Masch 18U 2008 11:45:24 44 ']
toachicr
=) DurmiesUnderstanding the Westher's Water Cyde ‘Wb Page  Masch 18th, 2006 111434 AH o
™ £ p18in we Pocket Word Masch 18th, 2008 1114%:24 AN )
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8] water crele Wk Page  Massh 1Bth, 3009 1143:24 Ak )
Figure 37
Moving projects

In addition to copying projects to students, you can also move projects. Moving projects is like
cutting and pasting. When you copy a project, the project is left in the original location and copies
are put in the new locations. However, when you move a project, it is removed from the original
location and moved to the new location. This can be useful if you accidentally copy a project to the
wrong student — you can simply move it from one student’s folder to another.

To move a project:
1. Find the project you wish to move by clicking on the appropriate computer from the list on
the left side of the screen. For example, if you want to move a project from your own
computer, click on your computer from the list.

2. Check the boxes next to the project or projects you wish to move (Figure 38).

move | copy | archive | delete

Lazt Synct Tuesday, March 15th, 2008 9:39:19 AM

Current
| Name Type Last Sync Shared
= Maya Project HLE Project March 18th, 2008 9:26:51 AM o
] Mayan Numbers Sketchy March 18th, 2008 9:26:51 AM N
@ the Mayas Microsoft Ward March 18th, 2008 9:26:51 &AM 7
E'"QThe - PiCoMap March 18th, 2008 5:26:51 AM of

Last Synci Tuesday, March 15th, 2008 %:39:19 AM

Figure 38

Once you have selected the project or projects you wish to move, click the “move” button located
above the list of projects and files (Figure 39).

" move | copy | archive | delete
Lazt Synct Tuesday, March 15th, 2008 9:39:19 AM
Current
| Name Type Last Sync Shared
¥ @ Maya Project HLE Project March 15th, 2008 9:26:51 AM 5
] Mayan Numbers Sketchy March 15th, 2008 9:26:51 AM N
@ the Mayas Microsoft \Ward March 18th, 2008 9126:51 AM L
E'"QThe - PiCoMap March 18th, 2008 5:26:51 AM of
Last Sync: Tuesday, March 15th, 2008 9:39:19 AM
Figure 39
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3. A window will appear asking where you would like to move the project to (Figure 40). Unlike
when you copy projects, you can only move projects to one user, not to whole groups.

‘A Mr Teacher
= Class 1
#_] Blue Group
=iy Red Group
@& John
& Kate
® Chris
ﬂ Ernka
& John
& Kate
+i] Class 2
& teacher

4. To move projects to an individual, click on their name on the list (i.e. click on “Kate" in the
list shown above).

Figure 40

* NOTE: Just like when you copy projects to a student, projects that you move to a different folder
will appear in bold until the person syncs and receives the projects.

Providing feedback
Another feature of GoManage is the ability to send feedback to your students. Feedback can be
provided in one of two ways. You can either leave comments on GoManage, which students will
see when they log into their own GoManage accounts, or you can send a file containing feedback
to a student’s computer, which they will receive when they sync.

Leaving comments on GoManage

Comments provided on GoManage will be visible to students when they log in to their own
GoManage accounts, but will not be sent to their computer.

To leave comments on GoManage:
1. Select the student for whom you would like to leave the feedback by clicking on their name
on the left side of the GoManage screen.

2. Locate the file under which you want to leave the feedback from the list of files in the
“current” tab.
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3. Click on the icon of the pencil and paper ¥ to the right of the file (Figure 41).

Wiaw Fitan Dy Miner
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Figure 41

4. An “add comment” window will appear (Figure 42).

From: mrteacher
Text: ‘

cancel | ok

Figure 42

5. Type your comment in the text box, then click “Ok.” Your comment will appear under the file
name (Figure 43).

-
e Vigw Filngs Defauin Pl
GoManage i - w|  -Send Feeheck- v
Inanft 5
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Figure 43

* NOTE: Comments cannot be deleted or modified once they have been added.

Sending feedback to a computer

Feedback sent to a student’s computer via GoManage will be transferred to the computer the next
time the student syncs after the feedback has been generated. This feature can also be used to
send files to a student’s computer, such as Word and Excel files.

To send feedback to a computer:
1. Select the student to whom you would like to send feedback by clicking on their name on
the left side of the GoManage screen.

Copyright 2008, GoKnow! Inc. Last Updated: Page 21
All Rights Reserved 10/07/08



2. Click on the arrow next to the “Send Feedback” dropdown menu at the top of the screen

(Figure 44). Click on “Upload File.”
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Figure 44

3. A “New File ltem” window appears (Figure 45). Click “Browse” to find the desired file on
your computer. You can send an existing file, or create a new file first, save it, then upload

it.

cancel | ok

Figure 45

4. Once you have selected the desired file, click “Ok” at the bottom of the window. If you do

not want to upload a file, click “cancel” to return to the main GoManage screen.

5. The uploaded file will appear on the student’s list of current files in bold (Figure 46). Just
like when you copy a file, the student will receive the feedback the next time he or she

syncs.
i
| iaoe Pt Bafasy Wilnes
GoManage “Wiew - »| |-SendFeedback- ¥
lagof
5 = — move | copy | archive | delete
Mr T .
;'-’_i rﬂf::. irr Barn By T“H[;IF:I‘II‘; Ak, OO a7 B
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‘iiff.‘.g.'.'""" — | [H essa review BSoft Word March 16th, 2008 14405 PH ]
‘-.... o [ & weatarc ek HLE Projset  Mach Dk, S008 § 14534 AM o
‘cr‘:m B water Cice Pocket Word Fasch 18t S008 114524 AN b
‘Ellka Grat Job oy your azzay ! As mrtmper arch Pioh, 2004 OF 3758 M
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Figure 46
* NOTE: See appendix A for a cheat sheet on sending feedback.
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Additional features

Resetting student passwords

Teachers are able to reset a student password if needed. The first time a student syncs, a
GoManage account is automatically set up. When students log in to GoManage for the first time,
they are prompted to create a new password. If they forget their password, you can clear it and
allow them to create a new one, or create a new one for them.

To reset a password:
1. Click on the name of the student whose password you want to reset from the list of

computers on the left side of the screen.

2. Click on “Reset Password” on the bar at the top of the screen (Figure 47).

Wigw Filten Crfasl Filow
Gﬂma HHQE = = - - Send Feedback - |+
loaof
= move | copy | archive | delete
=1 Mr Teacher
f LSt Synai Tuarday, March § b, 2008 Lt 27 P
=4 Class 1 Current
=) Blue Group - [ Eaal Sy AR
= Red Growp O Y Essay review Microsoft Waord March 1k saai0s Pl = [
L O 2 waterCrce HLE Profect  PMasch 1imh, S008 § 14324 AM oy
= ki [, [ — Podoet Ward Masch 18k, S008 1 54528 AM e
Figure 47

3. A window will appear allowing you to clear the password or set a new one (Figure 48).

® prompt user for new password at next login.
O cet user password to:

This will change the password associated with the
user, Are you sure you wish to do this?

cancel | ok

4. To clear the password, click the button next to “Prompt user for new password at next login’
and then click “Ok.”

5. To change the password, click the button next to “Set user password to” and enter a new
password in the text box, then click “Ok.”

6. Click “Cancel” to do nothing and return to the main GoManage screen.

Figure 48

Renaming student accounts
In addition to resetting student passwords, you can also rename student accounts.

To rename an account:
1. Click on the name of the student whose account you want to rename from the list of
computers on the left side of the screen.
2. Click on “Rename” on the bar at the top of the screen (Figure 49, next page).
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3. A window will appear with a place for you to enter the first and last name of a user (Figure
50).

First Name:

Last Mame:

cancel | ok

Figure 50
4. Type in the new name for the account, then click “Ok.”

* NOTE: Renaming an account only changes the display name on GoManage. It does not change
the name of the computer.

Logging out of GoManage

When you are finished using GoManage, click the “logoff” button located below the GoManage
logo (Figure 51), or simply close your web browser.

"o

GoManage

4 Mr Teacher
E‘ﬁ Class 1
Figure 51

* NOTE: GoManage will automatically log you off after one hour of no activity!
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Appendix A: Sending Feedback Cheat Sheet

Sending feedback is one of the most useful tools in GoManage. This feature allows you to upload
files and send them out to students. When making a project, you can upload files you have on your
computer and incorporate them into the project instead of having to retype existing documents!

Uploading a file and incorporating it into a project takes several steps. However, once you do it a
few times, it becomes very easy! Below is a “cheat sheet” outlining the steps of uploading a
document, incorporating it into a project, and distributing it to students.
Steps:
1. Upload a document
a. Click on your device on GoManage
b. Click on “send feedback” - “upload file”
c. Browse to the document you wish to upload
d. Click “OK”
Sync your device
Open or create project
a. Launch MyProjects on your device

b. Click on the name of the project into which you want to add the document and click
“open”, or click on “new project.”

4. Import document into project

a. Click on the type of document you wish to import from the list of resources on the
right side of the MyProjects screen (for example, if you uploaded a Word document,
click on the Word icon).

b. Click “import”

c. Navigate to the resource you uploaded on GoManage

d. Click on the resource, then click “import.” The document will appear in your project.
Sync your device
Copy project to students

a. On GoManage, check the box next to the name of the project into which you just
imported the document.

b. Click “Copy”
c. Click on the group or student to which you want to distribute the project.
7. Have students sync their devices

* NOTE: You can upload multiple documents before syncing. However, you have to upload them
individually — there is no batch uploading.
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Appendix B: GoSync

GoSync is an application that allows your computer to communicate with the GoManage server.
When you use GoSync, projects and documents on your device will be sent to the server so that
you can access them through GoManage. New projects and documents on the server will also be
sent to your device. This process of sending and receiving information is called “syncing.”

To launch GoSync, on the computer you wish to sync, go to the start menu - programs ->
GoKnow GoSync. The GoSync login window will appear (Figure A).

GoSync v1.1

)
GoSync

| o

Welcome to GoSyne vl1.1
Flease login.

Group Name:
Username: teacher -
LogIn | Settings | Bt |

Neiwork Up

Figure A

Make sure you see a message saying “Network Up” at the bottom of the login window. If you see a
message that says “Network Down,” ensure that your computer is connected to the internet. If you
are connected to the internet and you still see a network down message, contact your network
administrator or IT support staff at your school to ensure that the school’s network is working

properly.
* NOTE: If you have just turned on your computer or awakened it from standby mode, it may take
several seconds to reconnect to the network.

Using GoSync
1. Select your user name from the dropdown menu.

2. Enter your group name in the box next to “Group Name”

* NOTE: If you do not know your group name, contact your school administrator. You will
need to use the same group name and user name ever time you sync in order to ensure
that your device is synced to the correct location on the server.

Click “Log In.”
You will be prompted to enter a password (Figure B).

Flease enter password for

Figure B

* NOTE: If this is your first time logging in to GoSync, you will be prompted to enter your
password twice. You can leave it blank if you do not wish to have a password.

5. Click “OK” once you have entered you password.
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6. The sync window will appear (Figure C).

=~ GoSync
File  Tools
User.: teacher -
Device: teacher GoSync
Last Zyne: | ™
2/21/2002 12:30:20 P
Byne
Press Byne' to begin synchronizing your data with Gollanage.

Figure C

* NOTE: If you have never synced before, you will see a message next to last sync that
says “Never.” That message will change once you’ve completed the first full sync. Also, if
you cancelled your last sync, you will see a message saying “Incomplete.” This message
will also change once you’ve completed a full sync.

Make sure you still see a “Network Up” message. As when you first log in, if you see a
“Network Down” message, make sure you are connected to the internet.

8. Click the “Sync” button to begin syncing!

9. When you are finished syncing, you can close the GoSync window.

Quick tips

1.

If you get a “Network Down” message while syncing, wait a few moments to see if the
computer automatically reconnects.

You can always stop a sync at any time and sync again later.

You can sync as often as you want. Every time you sync, your work is backed up on the
server, so syncing frequently ensures that you always have a recent backup!

The first time you sync may take a while. This is normal. Depending on your school setup,
GoSync will sync all files in your My Documents folder, or only the files in the GoKnow and
GoSync folders on your computer.

Be aware that large files (i.e. music or video files) will take longer to sync.

To speed up syncing, under “Tools” > "Settings” in the main GoSync window, uncheck the
box next to “Force a Full Sync.” This will cause GoSync to only sync files that have been
changed since the last sync. If you notice that some of your files are not syncing correctly,
go back and check the box next to “Force a Full Sync.”

If files are accidentally deleted off the computer but are still on the server, you can check
the box next to “Restore Deleted Files” (under the “Force Full Sync” option in the settings
window). This will restore the files from the server to your device. However, if you have
deleted the files off the server, you will not be able to retrieve them!

* NOTE: For normal use, the box next to the “Restore Deleted Files” option should be
unchecked.

If you are having trouble syncing, check to see that you have the correct server address
either under the “Settings” button on the GoSync login window, or under “Tools” >
“Settings” in the main GoSync window, under the “GoSync Config” tab. You can get the
server address from your school GoManage administrator.
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Key GoManage Benefits

GoManage can perform many functions, and is used in many different ways. Listed below are
some of the key benefits teachers, students, administrators, and parents have taken advantage of
in the past:

GoManage restores students work should computers lose power, become damaged or fail
for some other reason. Of course, for this to happen, students must synchronize to
GoManage!

Teachers and administrators can login to GoManage to ensure student computers don't
contain inappropriate messages, games, and other software not approved by the school.

Students access their work from any Internet-equipped computer and can put it into
Microsoft Word, PowerPoint, etc.

Parents can login to keep tabs on their child’s learning progress and stay more connected
to the school.

It is easy for students and parents to print work from GoManage on the desktop or laptop
computer.

Instead of beaming to tens or hundreds of students, teachers can distribute due dates and
homework through GoManage!

GoManage enables the creation of a digital portfolio for computers. It's useful for tracking
student progress and writing improvement over months and potentially, years.

Instead of carrying mounds of papers back and forth to school, teachers grade work
paperlessly at home or wherever they have an Internet-connected computer.
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